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Keeping Up
By Paul Howard, NCTCUG
It was a hard-fought election, but the results are in.
The group’s slate of candidates for the Board of
Directors, both officers and members at large,
were elected unanimously. Personally, I ran out of
money to run TV spots in the battleground states,
but triumphed after all.
The group’s name change, to National Capital Technology and Computer User’s Group, was approved,
along with the proposed changes to the Constitution
and Bylaws. Thanks for your suggestions on
changes to our organizational documents. I believe
the revisions helped bring our governing documents
in line with the reality of today’s operation of the
group, and clarified some issues that were subject to
confusion.
You’d think with more than 15 years’ practice, I
could get it right. Unfortunately, I was unable to
readily convert the Word Perfect document I pre-

Inside

pared for the fiscal year 2004 Treasurer’s report to
Microsoft Word, which imports best to the MS
Publisher program Blair uses to produce the Journal. As a result, about half a dozen words were
dropped from the second paragraph of the article.
Also, Blair had to wrestle with the table of the cash
flow report, which I’d hoped would save her production time. The full report is on the web, along
with the latest versions of the Constitution and Bylaws, at: http://www.nctcug.org/orgdocs.html
(Continued on page 14)
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Digital Photography And Printing
by Charlotte Semple, President & Editor, Los Angeles Computer Society, California
Charles Mahan, Wi-Fi SIG Leader, Los Angeles Computer Society, California

Lee Otsubo is best known as The Digital Photo Guy.
He has become a familiar figure to many user groups
as he shares his knowledge and experiences in digital
photography. He emphasizes two basic topics in his
presentation:

You need to be aware of what kind of photography
you are interesting in doing and what you are going
to do with the photos in order to make the best use
of the finite number of pixels you have.

1) How to get the most out of a digital camera (or
how to buy one) and,

CCD

2) How to share and display great digital Photos.

Megapixels
Mega comes from Greek, meaning, great. In technological terms, it’s a prefix for millions. A 3.5-inch
floppy holds 1.44 mega bytes, which is 1.4 million
bytes of data. A megapixel is 1 million pixels.
So, “What the heck is a pixel?” A pixel is a made up
tech term for “picture element.“ Pixels are square.
If you look closely at a newspaper photo, using a
magnifying glass, you will see hundreds of tiny dots,
some dark, some light and some in between. As you
move the photo away from yourself, setting aside the
glass, you will not be able to discern the dots any
more, instead you will see the whole photo. Digital
cameras work the same way. They use millions of
pixels, (mega pixels, or MP), to make a photo. i.e. a 2
MP camera uses 2 million pixels. A mega pixel is a
measure of the camera’s capability to capture detail,
which is resolution.

The CCD (Charge Coupled Device) is the central
processing unit of the digital camera. It is somewhat
like the CPU in a computer, but unlike the CPU, the
CCD has only one function. It takes images and
munches and crunches them. The CCD of a 2 mega
pixel camera contains 2 million light sensors. Each
light sensor produces 1 pixel. Each pixel represents
1 of 16.7 million different colors. Each pixel has a
red, green and blue component of color. Each component is a byte (of data). Each pixel has three bytes
of data. A 2 MP camera produces 6 million bytes of
data. Enough data to fill five 3.5-inch floppies!

Cycle Time
The time needed for the CCD to munch and crunch
data and get it out of the way in time for the camera
to be ready to take another photo.

Lag Time
The time a digital camera needs to look at a subject
and fire enough electrical charge to be ready so that
when the shutter button is pressed, the camera will
capture the image of the subject.

Munching and Crunching
After the CCD captures the image it has to compress
it. A 2 MP camera uses (munches) 6 million bytes
of data for each picture at high resolution. This has
to be compressed (crunched) down to 1 mega byte of
data. Many cameras have different settings for resolution. Lee recommended that you keeps your cam-
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era on the highest setting and leave it there. If you
change it for a lower resolution shot and forget to reset it to the higher level, and you use the camera
again, thinking you are taking high-resolution shots,
you will be disappointed in the results. You can always throw away extraneous detail, but you cannot
put it in if you didn’t capture it in the first place.

Input — The Lens
This is the first and last place where there is any real
resemblance between the digital and film camera.
The usual focal length of a 35mm point and shoot
camera is anywhere from 35mm to 105mm zoom.
Most digital cameras have 3X zoom, which goes
down to the equivalent of 35mm, for a moderate
wide-angle shot, out to the equivalent of 105mm for
a telephoto shot.
There are two types of Zoom: Optical, which is
“real” zoom, and Digital, which is electronic trickery. When you activate the zoom function on a
35mm point and shoot film camera, you can hear the
lens moving in and out, increasing or decreasing the
size of the image to be captured. This is “real”
zoom. When the electronic zoom on a digital camera is activated, the zoom plays a trick on the image.
The lens captures the center section of the image and
stretches the pixels out to fill the frame. But one
loses some resolution and the photo will not be as
clear.
Using a photo imaging tool on your PC, and enlarging a photo large enough so that straight edges are
no longer straight, you can see the points of individual pixels. In tech terms, this is called “Jaggies.”
Under the same conditions when looking at a photo
of a person, you can see individual square pixels. In
tech terms, this is called “Pixelation”.
When buying a camera be aware of what component
of the camera is optical zoom and what is digital
zoom. Some “smart” marketers might advertise
their camera as having 6X zoom capability, where
they have multiplied the 3X Optical by the 2Xdigital. A 3X Optical camera is a 3X Optical camera.
Another way marketers might advertise a 6X Optical
camera is where they have taken a cheap 2X optical
zoom and bumped up the digital zoom to 3X, calling
their product 6X Zoom. You must be really careful
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to read the fine print. Don’t always go by the advertising printed on the box.

About Zoom
If you are taking photos at a back yard BBQ, and
you are able to fill the camera frame with subjects,
you probably will not need a zoom. If you are going
to be taking outdoor photos with subjects 20 to 30
feet away, a 3X Optical zoom camera is probably all
you would need. If you are in the “nose bleed” section of a sports arena, and your subjects seem to be
6-inches tall, you will probably need anywhere from
a 6, 8, 10 to 12X zoom. You should be aware of the
kind of photography you want to do so that the right
type of zoom lens can be obtained.

Output — USB
Most modern digital cameras will have a USB
(universal serial bus) port connection. If a camera
does not have this don’t even consider it. A slow
serial connection will drive you crazy. Simply plug
the USB cord that comes with the camera into the
computer and leave the camera end in a convenient
place for ready use. A card reader makes an easy job
of uploading the data from your camera into the
computer. A universal Card Reader accommodates
up to 6 different memory cards. Simply insert the
memory card into the reader and it will look to a
Windows machine, almost like a disk drive, and you
can drag and drop photo files from the memory card.

Memory Cards
These are compact flash memory cards. The particular type of memory card that came with your camera
is the type you should use. Not all memory cards are
universal. The real advantage of memory cards is
that they are removable and are fairly robust. Not
like ordinary film. Lee recommends that you should
carry at least two memory cards of a moderate range.
These are all electronic devices and sooner or later
you will corrupt data on a memory card. If you were
gullible enough to buy only one very large range
memory card, and go on vacation, and the card becomes corrupted, you are up the proverbial tree.
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You have two choices. Erase all the accumulated
data from the card and reformat the card, losing all
your photos, or not take any more photos. Neither
choice is desirable. If you had two memory cards,
the corrupted card can be removed and stored
away safely and the second card can be inserted
into the camera and you can continue taking photos. When you get home, the corrupted card can be
inserted into the card reader, and a rescue software
(Photo Rescue, http://www.photorescue.com) can
be fired up and most of the photos can be saved.

LCD
Instant gratification! You can see in an instant the
photo just shot (but wait for the Cycle Time). It is
not recommended that you waste time trying to
decide which shots to keep and which shots to discard while taking the shots. Wait until the photos
are transferred to your PC, and then make these
decisions. Each time you turn on the LCD the
power consumption increases by 2–3 fold, and
precious battery life is wasted. Also, when you
buy a digital camera, make sure it has an optical
viewfinder, and use it for much better shots.

Power
Most digital cameras use standard rechargeable
batteries. If you use regular alkaline batteries a
digital camera will just eat them up in no time. The
most popular batteries are Nickel Metal Hydride
(NiMH). Some people might use Proprietary Lithium Ion batteries, proprietary meaning expensive.
The lithium ion batteries are very powerful and
long lasting, lasting 3-4 times
longer than the
nickel metal hydride batteries. A
warning about
these batteries —
be very careful
how and where
you store them.
Don’t carry them
loose in a pocket
with anything
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containing metal. You could start a fire. These batteries should be stored safely in some sort of plastic
containers.
Now, what do you do with all these great photos?
Print them! In order to get the best quality prints,
there are 4 components that impact the quality of
the prints:

1. The printer
Use a good quality photo ink-jet printer. Epson,
Hewlett Packard, and Canon are the most well
known and written up in most photo magazines.
They also do have a range of good quality inexpensive printers.

2. Paper
Use good quality paper. This might be somewhat of
a surprise, but Epson produces the best quality
prints on expensive Epson paper (about $1.00 per
an 8.5 X 11 sheet). The same goes for Hewlett
Packard and Cannon. Keep in mind that there are
certain combinations of paper and printer that will
never work. It is not advisable to use Epson paper
with a Hewlett Packard printer, or HP paper with a
Canon printer. etc. . If you only print about 20 to
30 photos per month, live a little and buy the expensive paper. If you print hundreds of photos per
month, look around for deals, but try a few sheets of
the paper first before buying a ream or you might be
stuck with a ream of unusable cheap paper.

3. Image
As Lee mentioned before, keep your cameras set at
the highest resolution and you will get high quality
prints. There are two exceptions: a) the use of “raw”
or “tiff” mode is mostly for when one needs the
highest quality possible. e. g., taking wedding photos where everything is set up, people are standing
quietly, the lighting is just right, and the camera is
on a tripod. Raw, or Tiff, captures every single
pixel and does not compress, creating huge files. b)
Taking photos for the Internet, such as for eBay.
Use a low resolution that does not require compression and reduces the time between taking the shots
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and uploading them to eBay. If you keep your cameras at the highest resolution you will have the least
compression.

4. Software
The software is the most critically important component in producing good prints. Remember when Lee
talked about those square pixels where just 1 pixel
represented 1 of 16.7 million different colors in a
RGB color scheme? Well, printers print round dots,
each with a color spectrum of between 5 to 10 thousand different colors in a CMYK (Cyan, Magenta,
Yellow and Black) color scheme. For a printer to
make the transition from square pixels to round dots,
it needs the support of good high quality software
that is specifically written to do that job. (Someone
actually figured out how to insert a square peg into a
round hole!)

CDs
The most important reason for copying digital photos onto CDs is, digital photos have no negatives. If
you transfer you photo to your computer, and if you
computer fails (and it will by Murphy’s Law) and
you have not copied them to CDs, you are out there
up the proverbial creek. Your photos are history. The
CD is your “negative”.

(Continued from page 9)

**Products marked with phrases that do not describe
the transaction, including:
“For distribution with a new PC only”
“Special CD for licensed customers only”
“Not for retail or OEM distribution” or
“Academic price – not for use in a commercial
environment”

Note that counterfeiters often use these types of
phrases to fool consumers into believing that they
are getting genuine product that was over-stocked or
otherwise deserves to be discounted.
Consumers dealing with software vendors over the
Internet should also beware of:
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The format used by digital cameras for compression is JPEG (Joint Photographic Experts
Group), a powerful technology and an excellent
compression log rhythm. There is, however, an
insidious idiosyncrasy you must be aware of
with JPEG images. After you have downloaded
your photos into your PC. and you pick out a
photo to examine and admire, do something
with it and save it, it is re-compressed. If you
open it again and save it, it is re-compressed
again. Each time you open a photo and save it
after viewing it, it is re-compressed. Each time
it loses a little more detail, eventually becoming
one ugly photo. When this happens, and you
have a pristine copy of the photo on a CD, recopy it to the PC and you will have a fresh
photo to work on. The best advice is not to save
it each time you look at it. You can work with a
photo, changing its composition and print it
without saving the changes. CDs, when used
regularly, also degrade. So make 2 CDs of your
photos, keeping one in a safe place.
There is no restriction against any non-profit group using
this article as long as it is kept in context with proper credit
given the author. The Editorial Committee of the Association of Personal Computer User Groups (APCUG), an international organization of which this group is a member,
brings this article to you.

**Companies or individuals unwilling to verify
their identity or full business name or provide a
physical street address and telephone number for
follow-up after the transaction has occurred.
**Online distributors unwilling or unable to provide adequate or satisfactory descriptions of their
return, service or warranty policies.
**Online distributors that offer unusual inventory
explanations (e.g., special deals with the software
publisher, liquidated inventories or acquisition
through bankruptcy sales).
**Vendors offering software products at prices and
in packaging inconsistent with offerings through
legitimate retail channels.
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TECH NEWS (July 2004)
By Sue Crane, Editor, Bearly Bytes, Newsletter of the Big Bear Computer Club

Get your DDR SDRAM now! With back-to-school
demand for more PCs due to pick up during the
month of July, computer memory prices are expected to rise again. After an unexpected spike in
April, prices have fallen about 24% to around
$4.80 for 256 megabytes of DDR SDRAM from a
peak of $6.30.
Hewlett-Packard Co. will replace memory modules in up to 900,000 HP notebooks with an
“industry-wide” design flaw that can cause system
lockups. The problem is tied to the interaction of
DRAM and Intel chipsets. HP’s replacement program will send the customer a kit containing a
screwdriver and instructions for replacing the
faulty modules. The customer can then ship the
DRAM to HP and receive a new module free. HP
appears to be the only computer manufacturer taking action. A representative from Dell Computer
Corp. said the company is “looking into it.”
Computer trade show Comdex, once the biggest
event on the tech calendar, has been canceled this
year, making room for the growing interest in
shows emphasizing consumer electronics and specialist IT gear.
Personal computer makers have been eager to
revolutionize the way people watch movies, listen
to music and record their favorite TV shows. Last
month Intel launched new core logic and motherboards, along with a new socket format for the
Pentium IV, targeting the high-performance desktop PC market. The new technology gives PCs
more powerful sound and graphics, a speedier link
for peripherals and memory, and an ability to run a
wireless data network, turning the PCs into home
entertainment devices. The inclusion of Wi-Fi access point technology allows new PCs with the
chipset to become wireless gateways for other mobile devices. Intel was unable to ramp up the WiFi technology in time for the launch, but Intel
spokesman Dan Snyder said Intel will announce
the technology now and provide availability later
throughout the year.

Sun Microsystems has designed 3-D interface software to compete with the PC desktop and file folders. Sun’s “Project Looking Glass”, is a 3D interface allowing documents or images to be turned
sideways and spun around so that notations can be
made on the back. Sun is initially planning to use
the technology on desktop machines running Linux
or Sun’s Solaris operating system. Sun president
and COO Jonathan Schwartz says Project Looking
Glass reflects a swing in software development
back toward desktop machines instead of running
programs on centralized servers.
Meanwhile the digital home has become a reality!
At the Samsung Tower Palace in Seoul, $1 millionplus apartments are outfitted with Internet-enabled
ovens, security cameras and wall-mounted flatpanel displays. The company has tests under way in
Canada, Australia and Europe, and it recently struck
deals with two U.S.-based home builders to conduct
digital home trials in the U.S. Wiring homes in the
U.S. will cost from $2,000 to $10,000.
The Virtual Doctor Will See You Now. Some
health care providers are offering e-mail medical
advice and “e-visits”. So how do you get doctors
who don’t want to use e-mail because they are too
busy, worried about privacy, and not being paid for
it to buy into the program? Pay them, of course! In
August, Blue Cross & Blue Shield of Massachusetts
will start paying primary care physicians for ‘Web
visits’ with their patients. Blue Cross will be expanding a pilot program that pays doctors to respond to patient e-mails. Watch for the program in
your area…
From truckers in the U.S. and Canada to Yak farmers in the mountains of Nepal, more people are
jumping in with wireless technology. Yak farmers
are taking advantage of a wi-fi network set up in a
remote region to keep in touch with their families
where there are no phones or other communication.
And at networked farms of the future, farmers sit in
their pickups with a laptop, drive robot tractors and
even feed the hogs remotely. Two Georgia farmers
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are already using the technology: One uses wireless
video to monitor vegetable packing; another uses a
wireless network equipped with GPS to monitor irrigation systems. Robotic tractor technology has also
proven useful in insect control. The Texas Department of Transportation (TxDOT) hopes to reduce
fatigue-related accidents by enticing drivers with free
Wi-Fi hotspots so they’ll stop more often and check
their e-mail. Meanwhile, the whole city of Chaska,
Minnesota will soon be blanketed by a Wi-Fi hotspot and city officials plan to offer wireless Internet
access as a municipal service for about $16/month for
home users, creating a “connected community.” The
manager of arena operations for the Charlotte Bobcats is including Wi-Fi wireless in the design of a
new $265 million arena. He says, “Some people will
think this is the geeky thing, the nerdy thing. But they
were probably saying that 10 years ago when other
people were going to Web sites and using e-mail.”
Other sports teams are following suit; Giants CIO
Bill Schlough says: “It’s like walking into Starbucks—except our Wi-Fi is free!”
Game developer Respond sign has created a first-ofits-kind game geared toward helping the player lose
weight through exercise and diet. The game, titled
“Yourself! Fitness”, is designed for the Xbox and
features a virtual personal trainer who guides the
player through a customized set of exercises and diets; players advance to the next level when certain
fitness goals are met. Next year the Xbox Live version will allow players to use a wireless headset to
chat with each other during their workouts
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“Toxic dust” found on computer processors and
monitors contains chemicals called PBDEs which
have been linked to reproductive and neurological
disorders. “The levels in the dust are enough to
raise a red flag, but not enough to create a crisis,”
said Dr. Gina Solomon, senior scientist at the
Natural Resources Defense Council and assistant
professor of medicine at University of California,
San Francisco. “I have an old computer monitor
in front of me now, and I’m not about to throw it
away. But when I get a new one, it darn well will
be free of these chemicals.” Dell, along with Apple Computer Inc. and others, stopped using
PBDEs in 2002.
The U.S. Supreme Court ruled that a federal law
designed to restrict Internet pornography violated
Americans’ rights to freedom of speech and upheld an injunction excluding prosecutors from
filing criminal cases under the Child Online Protection Act, or COPA, until a full trial takes place.
COPA restricts the use of sexually explicit material deemed “harmful to minors” on commercial
Web sites. But the law isn’t dead: COPA now
goes back to a Philadelphia appeals court for a
full trial.
There is no restriction against any non-profit group using this
article as long as it is kept in context with proper credit given
the author. The Editorial Committee of the Association of
Personal Computer User Groups (APCUG), an international
organization of which this group is a member, brings this article to you.

“The Effect of File Sharing on Record Sales,” released by Harvard Business School professor Felix
Oberholzer-Gee and his co-author Koleman Strumpf,
of the University of North Carolina caused a ruckus
in the music industry. The team concluded Internet
music piracy not only doesn’t hurt legitimate CD
sales, it may even boost sales. The researchers contend that most downloading is done over peer-to-peer
networks by teens and college kids, groups that are
“money-poor but time-rich,” and wouldn’t have
bought the songs they downloaded, anyway. The
team also claims illegal downloading may actually
help the industry with an older crowd who download
a song or two and then, if they like what they hear, go
out and buy the music.
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Whither The Yellow Box?
By Moe Norris, Topeka PC Users Club, Kansas

Eastman Kodak Company, an icon in the photographic industry for more than 100 years, dropped
a bombshell last September when it announced that
the company would shift its focus from film and
film-based products to digital equipment and processes! And it has resolutely continued down that
path. In January 2004 the company announced
that by the end of this year it would no longer be
selling re-loadable film based 35mm cameras, including APS models, in the U.S., Canada, and
Western Europe. The “throw away” (i.e., one-time
use) cameras will be the only Kodak film camera
available in the west. The number of different
films provided to retailers will be reduced, concentrating on just the most popular lines. Production
of its Carousel film projectors was scheduled to
cease the end of 2003.
Kodak said that it plans to continue providing
35mm cameras in emerging markets, such as
China, India, Eastern Europe and Latin America,
and will introduce six new film cameras in those
markets this year. It predicts rapidly growing markets for cameras and film in those countries, in
contrast to what is being seen in the west where the
demand for film-related products is shrinking
much more rapidly than anticipated, while purchases of digital cameras continue to grow dra-

matically. Kodak’s array of digital cameras now
extends from point and shoot consumer models to
high-end professional (read very expensive) digital
cameras and camera backs. It will increase its production of inkjet printing papers, and plans to introduce a new line of consumer ink jet printer models
to go head-to-head with the well-established offerings from HP, Epson, Lexmark, etc.
Kodak’s landmark shift in focus represents a profound change for the world’s largest filmmaker, and
a huge gamble. The success of the move remains
uncertain. Just when Kodak needs increasing film
revenues to underwrite the costs (in the billions) of
this transition, film sales are dropping substantially.
Since 1997 Kodak has reduced its workforce by
more than 30,000 jobs. Another 15,000 jobs will be
eliminated in the next two years in a further effort to
reduce costs. Success is not a given. If fortune does
not smile on Kodak, then not only may the Yellow
Box disappear, but the company itself may go down
the same path — and it won’t be a Yellow Brick
Road!
There is no restriction against any non-profit group using this
article as long as it is kept in context with proper credit given the
author. The Editorial Committee of the Association of Personal
Computer User Groups (APCUG), an international organization of
which this group is a member, brings this article to you.
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Can You Really Buy Popular “Software At
Rock Bottom Prices” Online?
by Linda Gonse, Editor of Nibbles & Bits, Orange County IBM PC Users’ Group, California

Probably you, and millions of others, have received
e-mail offers with subject lines similar to these:
Unbeatable software deals
Amazing prices on software
Take 95% discounts on Adobe, Microsoft, Corel
products from Putnam’s Stuff Store
Receive discount ticket on Corel, Adobe, Microsoft software from Koenig’s Stuff Store

according to the Business Software Alliance (BSA)
estimates. The group, which represents some of the
world’s largest software companies, including Microsoft, Adobe and Autodesk, does not know how much
money the industry has lot to online piracy.”
Still, user confusion about piracy prevails. Microsoft,
attempting to educate software buyers, has posted a
document that points out warning signs of counterfeit
or illegal software. (Unfortunately, most of the warning signs apply to software already purchased.)
Microsoft’s warning signs of counterfeit or illegal
software:

Get software at rock bottom prices

What’s more you may have seriously considered
purchasing the programs described in the e-mails at
prices that you’ve only seen in your dreams. Here’s
an example in one message:
Looking for inexpensive high-quality software?
We might have just what you need.
Windows XP Professional 2002

$50

Adobe Photoshop 7.9

$60

Microsoft Office XP Professional 2002

$60

Corel Draw Graphics Suite 11

$60

These amazing prices are not legitimate. They represent the work of software pirates who are trolling
for customers, or illegal sales. Do not take the offers
at face value. Stop and ask yourself how it is possible for programs that sell for hundreds of dollars to
be discounted for a fraction of their usual retail cost.
Certainly, these products are not even selling at
wholesale, much less for these unbelievable prices.
And, if the companies did offer programs at these
prices, you would be reading about it in your newspaper, or hearing about it on television or radio, or in
your user group.
A Washington Post article said, “The U.S. software
industry loses at least $13 billion a year to piracy,

Prices that are “too good to be true.”
Products that are missing key elements such as user
manuals, Certificates of Authenticity, or end-user license agreements. Pirates often sell only the CDROM and jewel case without retail packaging. Look
for the Certificate of Authenticity on the retail box.
On all new machines, with the release of Windows
2000, the COA label is found on the tower of the computer. If you acquire a new computer and it doesn’t
have the COA label on the tower, you should question
whether the software loaded on the machine is genuine.
Software or components that appear to be of poor
quality including:
**Back-up disks or CD-ROMs with handwritten labels.
**Poor imitations of security features such as edge-toedge hologram etched into Windows 2000 and Office
2000 (first service release) CDs, or poor imitations of
the hologram found on the hub of the Windows 98 CD
that shows the word “genuine” when tilted in the light
**Low quality print, letters that aren’t evenly spaced,
etc.
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Browser Power
by Vinny Labash Sarasota PC Monitor, Sarasota FL PC Users Group www.spcug.org

Imagine a gigantic library, thousands of times larger
than any other library in existence. Imagine enormous shelves filling this library in every direction as
far as the eye can see, so high you have difficulty
seeing the tops of the shelves. The shelves are filled
with books of various sizes. Some books are as
small as one page. Others are hundreds of thousands
of pages thick. The books are randomly distributed
throughout the library.
Patrons of the library enter and leave at the rate of
thousands every second. They examine books,
sometimes copying portions or all of their contents.
On the floor of the library are dozens of independent
groups of workers cataloging, indexing, and classifying the library’s contents.
The library building is the structure of the internet.
All of the hardware, connectors, switches, routers,
cabling, and other assorted apparatus and paraphernalia that make up the internet are found in this cyberspace library. The shelves represent the World
Wide Web. They are the containers that house information stored on web sites. The books stand for the
websites. Some are small, like most personal web
sites. Many are huge corporate web sites which can
run into hundreds of thousands of pages. Millions of
other web sites fall between these extremes.
Patrons of the library are people like you and me
using it for data, entertainment, doing research, and
many other things, traditional and unorthodox. The
independent groups of workers are developing search
engines and further methods to help us find what we
want.
If you can imagine this scenario, you have a good
grasp of how the internet actually works. It is the
most magnificent assortment of information that has
ever existed, with a really lousy card catalog.
Where does your browser fit? It’s the tool that allows you to access information stored on web sites.
Information can be text which you can read. Information can be in the form of photographs, drawings,
and other kinds of graphic images. Your browser’s

versatility lets you listen to sound files and view
video clips. In most cases you can transfer any of
this information from a web site to your PC for your
personal use without having to learn any sophisticated computer “tricks”. All that is necessary is for
you to understand a few essentials about how your
browser works.
Begin by opening your browser after starting your
PC. You can do this from a menu option or click an
icon on your desktop, but you probably already
know that.
You are undoubtedly familiar with the Explorer’s
standard tool bar and the basic browser internet navigation functions. Let’s look at some tasks not covered by the toolbar.
To do more than the basics with the internet, you
need access to the latest internet news, software updates, tips, and tricks for using your browser. Microsoft devotes a portion of its website to this function and they call it “Microsoft at Home”. While
some of the content is advertising for its products,
the site does contain a lot of useful information.
Here’s how to add it to your Favorites list.
1. On the File menu of your browser’s Menu bar,
click Open.
2. Type http://www.microsoft.com/athome/
default.mspx .
3. Click OK.
4. From the Favorites menu, click
Add to Favorites.
5. Select a folder if you like, and then click OK.
Before you leave the “Microsoft at Home” page,
select Print Preview from the File menu. Notice that
the material selected for printing is “truncated”, cut
off at the edge of the right margin. Microsoft didn’t
program that portion of its site with printing in mind.
There isn’t a lot you can do about it because you
can’t change Microsoft’s code. We bring it to your
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attention because you shouldn’t drive yourself
crazy trying to fit the information on the page.
This is not unique to Microsoft. Most internet
pages are not concerned with printing material, but
with displaying it properly while accommodating
the eccentricities of different browsers.
Open the File menu again and move your mouse
pointer over the Send option. The submenu allows you to email the whole page or email only
the URL (recommended), which saves a lot of
space on your email note. You can also create a
shortcut to the site on your desktop.
If you see a picture you like on a website, move
your mouse pointer over the image. If the pointer
changes into a hand icon, right-click on the image.
The popup menu will show that you can email the
image, copy it to your PC, set it as background on
your desktop or print it. Imagine that!
After performing a search, the browser brings you
to a web site, and the word or phrase you searched
on is nowhere in sight. Rather than scrolling
through the site searching manually, hold down
the Ctrl key and tap the F key. (Ctrl+F) This
brings up a Find dialog box where you can type in
the search phrase in the text area and your browser
will find it for you. You can also access this
handy tool from the Edit menu.
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Page section. Select the web site you wish to have
as your home page. Change it as often as you like.
The History section lets you decide how long you
want your wanderings on the internet to be stored
on your computer. Select the number of days you
feel comfortable about or delete the history altogether. The choice is yours.
Click on the Accessibility button. In the Accessibility dialog box, check the box that says Ignore
font sizes specified on web pages. This allows you
to adjust text size on web sites. You can do this
from the View menu or hold down the Ctrl button
and rotate the wheel on your mouse button.
There’s a lot more you can do with your browser
than you might suspect, and this article hardly covers it all. However, you should now have a good
idea of the power residing in your browser and be
encouraged to explore its capabilities on your own.
There is no restriction against any non-profit group using this
article as long as it is kept in context with proper credit given the
author. The Editorial Committee of the Association of Personal
Computer User Groups (APCUG), an international organization
of which this group is a member, brings this article to you.

The View menu has a lot to offer. This is where
you turn your toolbars on and off. If you are missing a toolbar, look here first.
Open the Privacy Report on the View menu and
check if Explorer is restricting or blocking any
cookies from the site. The Privacy Report dialog
box also allows you to override cookie handling
from any individual web site. Click on the Settings button and then the Edit button. You can
specify which web sites are always or never allowed to use cookies, regardless of the site’s
stated privacy policy.
Open the Tools menu and select Internet
Options . On the General tab, look at the Home
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Selections From The DealsGuy
Bob Click, Greater Orlando Computer User Group

Interesting Shows
I worked the PASS (Professional Association of
SQL Servers) show [ http://www.sqlpass.org] and I
was never more lost since I know little about SQL
servers. The exhibit area was 10,000 square feet and
they expected about 1200 attendees. In their Internet
Café, the computers were on top of the table, rather
than hidden. They had a clear plastic side and green
florescent lighting inside that made them an eyecatcher. It was a busy spot and also had high-speed
hookups for attendees’ laptops. Sorry I’m not smart
enough to give you more info. I can tell you though
that the tasty cookies and refreshments served during the show were great.
I also worked a day for the setup of the Electronic
Boutique Gaming show, but didn’t work the actual
show day. It was a one-day show open for eleven
hours. All the big names in the game industry had
booths and there were stacks of free expensive game
cartridges and disks all over the place. I didn’t capitalize on them since I am not a game person. Friends
sure criticized me for that. It was 10,000 square feet

of exhibit area and they expected about 1200 managers and other VIPs. Microsoft’s X Box booth
was the largest there with large boxes of goodies
for their attendees. This show and the one above
were held at the beautiful Gaylord Palms Resort in
Kissimmee, FL. It’s hard to get used to computer
geeks sitting and laying all over the floor when
chairs are handy.

Explosive Information
This has nothing to do with gas stations, but in EE
(Electronic Engineering) Times [http://
www.eet.com] there was a story about exploding
batteries in cell phones and laptop computers. I’ll
quote one of their statements: “Rising reports of
incidents in which counterfeit batteries have overheated, caught fire or blown up are dogging a
portable systems industry caught between the
slow pace of battery technology and the quick step
of new features at even lower costs.” Companies
are very worried about consumer confidence when
such news reaches them and they say the problem

Washington Area Computer
User Group (WAC)Meetings
WAC Meetings will be held on December
18, 2004 and January 22, 2005 (NOTE: 4th
Saturday!), 12:30 PM to 3:30 PM. at the
Fairfax County Government Center, 12000
Government Center Parkway, Fairfax, VA
You do not need to be a member to attend. For
more information on WAC meetings and events,
call the WAC AnswerLine (voice) at (703) 3707649. Also see WAC’s Web Site at
http://www.wacug.org/
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batteries are counterfeit. Here are some URLs for
more information in the event you might have a
counterfeit battery. [http://www.cpsc.gov/
CPSCPUB/PREREL/prhtml04/04559.html] concerning recalls, [http://www.cpsc.gov/CPSCPUB/
PREREL/prhtml04/04068.html] other recalls, and
[http://www.nokia.com/nokia/0,,49192,00.html] on
how to spot a counterfeit battery. It was an interesting article about the problem and possible technology and safeguards.

Don’t Lose Track Of Time
This item is an announcement I received and these
people are offering UG members a 20% discount.
Here is their statement edited. “Our company,
Maximus Software Ltd, would like to announce the
release of Time Meter for MS Outlook 2.4, a simple
but very beneficial software application capable of
tracking expenses and time spent working on certain project(s) for Microsoft Office 2000/XP/2003.
The program can be used by individual consultants
and freelancers for billing their clients, or by corporate managers to track expenses, performance and
contributions of each employee. Most importantly,
the program acts as a plug-in for MS Outlook, thus
eliminating the need to spend time learning how to
use a new application and getting familiar with interface.
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link to get a discount: [https://www.regnow.com/
softsell/nph-softsell.cgi?item=356015&ss_coupon=AGPR-0RAO] Product Page: [http://
www.panterasoft.com/file-recovery/index.html]

“Flash File Recovery is a nifty application that every
photographer should be aware of. Essentially, it can
recover any previously deleted image file. Plus, it is
capable of salvaging pictures from damaged or corrupted flash drives (including camera’s built-in
memory) and memory sticks. The list of supported
storage media includes but is not limited to SmartMedia, CompactFlash, Memory Stick, MicroDrive,
xD Picture Card Flash Card, PC Card, Multimedia
Card, Secure Digital Card, and many others. Flash
File Recovery “resurrects” images from formatted,
damaged, corrupted (unreadable), or defective storage media.”
This column is written to make user group members aware of
special offers or freebies I have found or arranged, and my comments should not be interpreted to encourage, or discourage, the
purchase of any products, no matter how enthused I might sound.
Bob (The Cheapskate) Click [bobclick@mindspring.com]. Visit my
Web site at [http://www.dealsguy.com]. I’m working on new pages
for 2004 announcements I received, but slowly.

The price of a single copy is $74.95 US Dollars.
Product Page - [http://www.timemeter.com] The
discount coupon code is ‘3481051341’ and is redeemable at http://www.timemeter.com/
coupon.shtml.”

Bring It Back – Please
Here is another announcement with a discount.
“Have you ever accidentally deleted a slew of pictures from a memory card before you transferred
them to the PC? Or formatted a card in the camera,
only to realize that your vacation pictures were still
on board? That’s the stuff that nightmares are made
of. Fortunately, Flash File Recovery is on hand to
save you from yourself. We offer 15% discount
making the price $42.08. Just use this direct order
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(Continued from page 1)

USB Port Struggles
I mentioned in an earlier article installing add-in
cards for USB 2.0 ports, on machines with Windows XP as the operating system. Ron Schmidt
bought the same card I purchased from CompUSA,
and had challenges with the installation under Windows 98SE. Ron brought his machine to the October SIG meeting, and the gang proceeded to help
with the installation.
All were puzzled by the insistence of the program
on loading additional components from Win98.
However, the USB 2.0 ports seemed to work,
and data could be accessed and written to a USB
hard drive and thumb drive. Ron reported back
that he had downloaded a special driver for the
Sandisk Cruzer thumb drive, and that it now
worked properly.
As the NCTCUG crew was working on Ron’s system, Jim Rhodes mentioned he frequently had trouble with USB devices not being recognized. Roger
Fujii pointed out that USB devices often work better when plugged in after boot up. When left
plugged in through system shut down and reboot,
they may not be recognized as the system restarts.

Gadgets
This meeting was also used as a showcase for a variety of tech toys. One of the exhibits was a Sears
“Endurable” flashlight, about the diameter of a
standard double D cell light, but only half as long.
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With substantial rubber end caps, this light uses 4 AA
cells, with illumination provided by 5 super bright
LEDs. Several members own this unit, and while
pleased with the apparent ruggedness and features of
the light, all agreed that the pushbutton switch, which
cycles through “Spot” “Flood” and “Both” settings,
requires excessive force to operate.
Micro Center’s latest flyer offers a three and a half
digit multi-meter (DVM850BL) by Velleman Components for $10. When first introduced, these hand held
meters, a replacement for the typical VOM (volt ohm
meter) would cost approximately $250. I built my
first such instrument from a Heathkit about twenty
years ago, and it cost about $100. The Velleman meter, about 2 3/4 inches wide and 5 ½ inches high, includes a “touch and hold” function, and back light.
Ranges: 5 - DC volts from 200mv to 600V; 2 - AC
volts 600 & 200; 5 - DC amps from 200ma to 10A; 5
ohms from 200 to 2 megohms; plus audible continuity; diode polarity / forward voltage drop; Transistor
hFE (gain) for PNP and NPN transistors. Includes
yellow rubber “shock / drop” shell with stand.
Several years ago I bought a similar digital meter
from Sears (Craftsman 82140) in a special package
(34-82146) that included a “fat pen” sized Voltage
Detector (92174) for $19.95 in a sale I’ve seen several
times since. The Sears meter doesn’t have the transistor gain range, including instead 1.5 and 9 volt battery
ranges, which tests with a load on the cell / battery in
question. A set of alligator clip adapters, which plug
on to test lead tips (Radio Shack 270-354A, $2) make
a handy addition to any meter.
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(Continued from page 14)

The “fat pen” voltage detector is a great safety device
if working on household electrical wiring, to make
sure that the circuit being worked is off, or when
troubleshooting switch legs in multi-switch circuits,
looking for unmarked hot wires. This detector works
on a proximity basis, without requiring a direct connection to a hot wire. A warning buzzer sounds, and
a light illuminates in the presence of 100-240 Volts
AC. Radio Shack carries a less sophisticated device
(22-106) for $6.95.
Another useful gadget for household electrical projects is a Circuit Breaker Identifier (Radio Shack 22113, $30). This is comprised of two parts, a signal
transmitter that plugs into a receptacle (or lamp
socket with an adapter) and a receiver that has a LED
lamp and piezo buzzer that will indicate which
breaker the transmitter is plugged into.
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Akro-Mills cabinets full of discrete electronic parts.
Last week, I found a “close out” item at Radio
Shack for $5 - an Electronic Components Tester,
which will identify transistor types and leads, diode
anode leads, SCR gate and anode leads. Catalog
22-330, if you can find it. Not surprisingly, it’s
referred to in Radio Shack’s automated documents
library as a “junk box tester.”
For those trying to identify or troubleshoot telephone wiring, a TP100 Tone and Probe Kit by TestUm, Inc. was displayed. This consists of a tone set
that injects a warble tone signal or “talk battery” on
a pair of wires. The companion tracer probe is used
to identify the correct conductors by picking up and
amplifying the test tone when the probe tip is near
the desired wire pair. About $90, available at Micro Center, along with a variety of LAN and telecommunications test equipment.

Bring your latest technology
gadgets to a meeting soon!

Having arrived at the computer hobby via life-long
interest in electronics and TV repair, I still have
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Articles, helpful hints, and other items of interest to readers of the NCTCUG Journal are
always welcome and will be published as soon as possible after submission. Priority is given to
members’ contributions. Items may be submitted via modem to the BBS or on diskette.
Submissions to the BBS should be uploaded to the Newsletter Conference and a message left
for the Editor. Files should be straight ASCII, unformatted, with C/R only at end of
paragraphs; no indents for paragraphs should be used. Preferred format for diskettes is MSDOS 3½ 720k or 1.44Mb. Diskettes in other formats may be submitted but there will be a
considerable delay in processing. If absolutely necessary, items may be submitted in hardcopy
only but these will also meet with delay.

Membership Policy
The National Capital Tandy Computer Users Group, Inc. is a non-profit [501-c(3)]
organization founded in 1977 to educate users of all Tandy computers and MS-DOS
compatible computers. Membership dues are $25.00 (U.S.Funds) per year, with a $5 surcharge
for international mail. Membership in NCTCUG includes membership in all SIGs, access to
the BBS and software libraries, and subscription to the Journal published 10 times per year.
Applications may be obtained at any club meeting, by downloading from the BBS, by calling
one of the officers or board members, or by writing to the club. A sample newsletter,
membership application and related information may be obtained by enclosing $1 and mailing
your request to Jim Rhodes, 201 S. Kensington Street, Arlington VA 22204.

Advertisement Policy

.

Members' advertisements: Ads are accepted from members for non-commercial purposes at no
charge. Copy should be sent to the Editor in the same format as article submissions.
Commercial Advertisements: Ads are accepted from commercial advertisers at the rate of $60
per full page, per appearance, with discounts for multiple insertions. Smaller ads are priced
accordingly. Payment for ads must be made in advance of appearance. Advertisers must supply
a permanent address and telephone number to the editor.

Reprint Policy
Permission to reprint articles from the NCTCUG Journal is given to school, personal computer
club, and nonprofit organization publications, provided that: (a) NCTCUG Inc. receives a copy
of the publication; (b) credit is given to the NCTCUG Journal as the source; (c) the original
author is given full credit; and (d) the article author has not expressly copyrighted the article.
Recognition is one means of compensating our valued contributors

Newsletter Staff
Editor
Blair Jones
202-362-7344
bjones44@bellatlantic.net
Exchange Newsletter and
Articles Editor
Ron Schmidt 301-577-7899

COMPUCENTER BBS
Is no longer in operation. It has
been replaced by the
‘compucenter’ mailing list at
http://groups.yahoo.com/

If you are moving
Please send your change of
address to the club PO
box as soon as possible to
avoid missing issues.

Thank You!
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(Continued from page 5)

**For Microsoft software, software components
being sold solely as a CD housed in a jewel case or
as a loose or individual end-user license agreement,
because these items are not distributed in this form
through legitimate channels.
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1st Wed. (12/1, 1/5) 7 p.m.
Virginia General Meeting
4th Wed (12/22, 1/26) 7 p.m. Internet SIG

Save your money and your time when you receive
“rock bottom” software offers. There are no unbelievable “deals” out there on name-brand software.
Let this be your guiding mantra:
If it sounds too good to be true—
on this you can rely—
just walk away and say no,
you can’t buy!
There is no restriction against any non-profit group using this
article as long as it is kept in context with proper credit given the
author. The Editorial Committee of the Association of Personal
Computer User Groups (APCUG), an international organization
of which this group is a member, brings this article to you.

NCTCUG, Inc.
P.O. Box 949
Arlington VA 22216

3rd Monday (1/17; none in December)
7 p.m. Board of Directors

Happy Holidays!

All meetings are at Carlin Hall, 5711 S. 4th St.,
Arlington VA: East off of Carlin Springs Rd, just
south of Arlington Blvd/Route 50.

